
 

Monitoring Video Using the Cisco Video 
Surveillance Operations Manager, Release 7.5

The Cisco VSM Operations Manager is a browser-based configuration and administration tool that can 
also be used to monitor live and recorded video. This document describes the features and options of the 
Monitor tab, which is the default window when you log in to the Operations Manager. Refer to the 
following topics for more information.
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Logging In and Changing Your Password
 • Related Documentation, page 55

Logging In and Changing Your Password
 • Logging In, page 2

 • Changing Your Password, page 3

Logging In
To log in to the Cisco Video Surveillance Operations Manager:

Step 1 Launch the 32-bit or 64-bit version of Internet Explorer on your Windows computer. 

Step 2 Enter the Operations Manager URL or IP address. 

Step 3 Enter your username and password.

 • The default credentials are operator/operator. 

 • The username and initial password for all other users is defined when the user account is created. 

 • All users are prompted to reset the password at first login.

Step 4 Select a Domain:

 • Choose the default “localhost” if your account was created using the Operations Manager. 

 • Select an alternative domain if instructed by your system administrator. 

Step 5 Enter a new password, if prompted.

You must enter a new password the first time you log in, or when your password periodically expires.

Step 6 Select a Site, if prompted (Figure 1).

Figure 1 Selecting a Site on First Login

 • Users with Site access are prompted for a Site on first login only, but not on subsequent logins

 • Users with no Site access are not prompted for a Site.

 • Users can also change their Site after log in, if configured. 

 • See the “Understanding and Changing Your “Site”” section on page 4 for more information.
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Logging In and Changing Your Password
Step 7 If prompted, ask your manager or other administrator to enter their “Approver Login” (Figure 2).

Figure 2 Approver Login

 • This second login is required only if configured.

 • If the approval is not successfully submitted within the time-out period, the login is denied.

Step 8 If prompted, complete the on-screen instructions to install or upgrade the Cisco Multi-Pane client 
software on your computer. 

 • This application is an Active X client that enables video playback and other features. 

 • Video will not play unless the Cisco Multi-Pane client software is correctly installed. 

 • If using the 64-bit version of Internet Explorer, you will be prompted to install the 64-bit version of 
the Cisco Multi-Pane client, if necessary.

 • You must have administrative privileges on the PC workstation to install the software.

 • You will also be prompted to install the required Microsoft .Net 4.0 component, if necessary. If your 
workstation does not have Internet access, the .Net 4.0 installer can be downloaded from 
http://www.microsoft.com/en-us/download/details.aspx?id=17718.

Note You must log in with a standard Windows 7 user account. Logging in with a Guest account can prevent 
video streaming and result in an error to be displayed in the video pane: “Cannot create RTSP connection 
to server. Check network connection and server health status.”

Changing Your Password
To change your password, click your username in the top right corner of the browser (Figure 3). 

Note Users from external systems (LDAP servers) cannot change their password using the Cisco VSM 
Operations Manager. 
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Logging In and Changing Your Password
If you forgot your password, contact your system administrator and ask them to create a new password 
(you will be prompted to change it when you log in).

Step 1 Log in to the Operations Manager (see Logging In).

Step 2 Click your username in the top right (Figure 3).

Step 3 Enter your current password.

Step 4 Enter and re-enter a new password.

Figure 3 Changing Your Password

Understanding and Changing Your “Site”
“Sites” are designated location hierarchies (a location and its sub-locations) where network connectivity 
between the cameras and servers is good. These Sites, however, may have low-bandwidth connectivity 
to cameras, servers and users outside the Site.

If the system is configured with Sites, and you are a member of a User Group that is assigned to a Site 
location, you will be prompted to select a Site the first time you log in (Figure 4).

Figure 4 Selecting a Site on First Login

 • Users with Site access are prompted for a Site on first login only, but not on subsequent logins.

 • Users with no Site access are not prompted for a Site. 
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Operations Manager Requirements
 • Users who have access to multiple sites, but do not have the option to change sites, will default to 
“Not in any site” when logging in.

 • If the Site is configured for Dynamic Proxy, users inside the Site are served by the Media Server in 
that Site (when accessing cameras inside the Site). Users outside the Site will receive video from a 
Dynamic Proxy server when accessing any camera inside the Site. 

 • Users who do not select a Site, are not assigned a Site, or select Not in Any Site will receive video 
from a Dynamic Proxy server for cameras in any Site where Dynamic Proxy is enabled.

Changing Your Site While Logged In

Users can also change their Site while logged in to the system. Click the current Site name in the top 
right corner and select a new Site (Figure 5).

Figure 5 Changing Your Site After Login

Operations Manager Requirements
See the Cisco Video Surveillance Monitoring Workstation Performance Baseline Specification for the 
workstation requirements when monitoring video.
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Using the Monitor Video Page
Using the Monitor Video Page 
Open the Monitor Video window to view video using the Cisco VSM Operations Manager.

Procedure

Step 1 Log on to the Cisco VSM Operations Manager.

Note See the “Logging In” section on page 2. You must belong to a User Group with permissions for 
View Live Video or View Recordings. 

Step 2 If prompted, complete the on-screen instructions to install or upgrade the Cisco Multi-Pane client 
software on your computer. 

Note This application is an Active X client that enables video playback and other features. Video will 
not play unless the Cisco Multi-Pane client software is correctly installed.

Step 3 Click Monitor Video.

Step 4 (Optional) Select View Menu to select a video grid of multiple cameras.

 • Select—select a blank layout. 

 • Select Views—select a pre-defined View.

See the “Selecting a Multi-Pane “View”” section on page 7 for more information.

Step 5 Expand the location tree and drag a camera from the list onto a viewing pane. 

Tip Enter a partial or complete camera name in the Find field to display matching cameras.

Tip You can also select a video pane by clicking in it, and then double-click the camera name.

Step 6 See the “Controlling Live and Recorded Video” section on page 10 to use the video playback controls. 
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Selecting a Multi-Pane “View”
Selecting a Multi-Pane “View”
To view video from more than one camera, select an option from the View Menu, as described in 
Table 1:

Figure 6 Video Layouts

Table 1 View Menu 

Menu Purpose Description

Select Layout Blank layouts Choose Select Layout to select a blank layout (Figure 6), and then 
select cameras for each pane.

Current View Save or reset the currently 
displayed layout.

 • Choose Current View > Save As to save a layout or view under 
a new name. Enter a name and location for the view. 

Tip Views can be assigned to the same location as the cameras, 
or to a higher level location. The new View appears under 
the Select View menu. Views are displayed in both the 
Operations Manager and Cisco Video Surveillance Safety 
and Security Desktop (Cisco SASD) application. 

 • Choose Current View > Reset to reload the last view or layout 
and discard any changes.
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Selecting a Multi-Pane “View”
Tip • To change the video in a View pane, drag and drop a camera name onto the pane.

 • Views can be accessed using either the browser-based Operations Manager or the Cisco Video 
Surveillance Safety and Security Desktop (Cisco SASD) application. The Operations Manager can 
display a maximum of 4 video panes using the 32-bit version of Internet Explorer, and up to 16 panes 
when using the 64-bit version. Cisco SASD can display up to 16 panes.

 • Double-click a video pane to fill the screen with that video (Figure 7). A preview of the other video 
panes is shown in a smaller grid at the bottom of the screen. Double-click the video pane again to 
return the grid to normal size.

Select View Display pre-defined views Choose Select View to select a pre-defined multi-pane view. Views 
can be configured to rotate video from multiple cameras to provide 
a virtual tour of a building or area. The video panes can (optionally) 
rotate video from different cameras to provide a virtual tour of a 
building or area.

Set Default View Define the view that is 
automatically loaded

The Default View is defined by each user and is automatically 
loaded when you click Monitor Video. 

1. Create one or more Views.

2. Select View Menu > Set Default View.

3. Select a View from the pop-up window and click Select.

Note The Default View is saved as a cookie in the browser and is 
unique to each user/PC. The Default View is not displayed 
if using a different workstation.

Table 1 View Menu (continued)

Menu Purpose Description
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Selecting a Multi-Pane “View”
Figure 7 Enlarge a Video Pane 
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Controlling Live and Recorded Video
Controlling Live and Recorded Video
Each video viewing pane in a Cisco Video Surveillance monitoring application supports the following 
controls and features. 

The features available on your workstation depend on the following:

 • The camera and system configuration.

 • Your user account access permissions.

 • The features supported by the video monitoring application. 

Contents

Refer to the following topics for more information.

 • Overview, page 11

 • Viewing Live Video, page 12

 • Viewing Recorded Video, page 15

 • Managing Video Clips, page 19

 • Using Record Now, page 30

 • Using the Pop-Up Menu, page 31

 • Understanding Video Pane Border Colors, page 33

 • Using the Privacy Mask, page 34

 • Using the Smooth Video Options When Viewing Live Video, page 37

 • Synchronizing Video Playback in Multiple Panes, page 38

 • Using Pan, Tilt, and Zoom (PTZ) Controls, page 42
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Controlling Live and Recorded Video
Overview
To view live and recorded video, log on to the monitoring application and drag and drop camera names 
onto the available viewing panes (you can also select a pane and double-click the camera name). Use 
Views to view multiple panes in a single window.

For example, Figure 8 shows a multi-pane view using the Cisco Video Surveillance Safety and Security 
Desktop (Cisco SASD) application.

Figure 8 Multi-Pane View using the Cisco Video Surveillance Safety and Security Desktop Application

Each viewing pane includes various controls that allow you to do the following:

 • Switch between live and recorded video.

 • Select the playback timespan. 

 • Pause, play, or skip forward and back.

 • Create and save video clips from recorded video

 • Mute or un-mute the audio (if available).

 • Synchronize the playback of multiple recordings.

 • Control the Pan Tilt and Zoom (PTZ) movements of a camera (if supported by the camera).
11
Monitoring Video Using the Cisco Video Surveillance Operations Manager, Release 7.5

OL-31739-01



 

Controlling Live and Recorded Video
 • Additional options are available by right-clicking the image. Options include synchronizing 
multiple viewing panes, recording live video, expanding the image to fill the screen, creating a 
snapshot image, and configuring smooth video options to improve playback performance when 
network performance is poor.

Note The available controls depend on the camera model and system configuration. For example, 
pan-tilt-zoom (PTZ) controls are available only on cameras that support PTZ. Recording options are 
available only if the camera is configured to record video. Synchronized playback is available for 
recorded video (not live video). See your system administrator for more information.

Viewing Live Video
Live video is displayed by default when you log in to the viewing application. Figure 9 summarizes the 
controls available in each viewing pane.

Figure 9 Video Pane Controls

1 Camera name—The source of the displayed video.
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Controlling Live and Recorded Video
Usage Notes

 • Some firewall policies on enterprise PCs can block live video streams from cameras. If this occurs, 
add the camera IP address to the firewall trusted list.

 • To maximize the video screens, move the new workspace to a separate monitor and double-click a 
pane to fill the entire browser window. To fill the entire monitor screen, right-click the image and 
select Full screen mode. 

 • To control the playback in multiple video panes, Shift-Click or Ctrl-Click to select the panes. 
The borders of all selected panes turn to orange. Controls and actions performed in one pane also 
affect the other selected panes. To deselect panes, select a single pane, or use Shift-Click or 
Ctrl-Click to deselect the panes

 • Live video may be delayed 1-2 seconds. Live video can be further delayed if the smooth video option 
is enabled. See the “Using the Smooth Video Options When Viewing Live Video” section on page 37 
for more information. 

2 Indicates the quality of the primary live video stream. If the live video quality is poor. , an alternative secondary or 
iFrame video stream can be automatically applied. 

See the “Using the Smooth Video Options When Viewing Live Video” section on page 37 for more information. 

3 Indicates live or recorded video (recorded video displays a time stamp such as ). 

4 Range Bar—Used with recorded video (see the “Viewing Recorded Video” section on page 15 for more information).

5 Seek—Used with recorded video to choose a playback time (see the “Viewing Recorded Video” section on page 15 for 
more information).

6 The green  icon indicates live video. Click the icon to switch to the recorded view .

7 Live video playback controls.

 • —Pause the video playback.

 • — Play the video forward at normal speed.

Note The other playback controls are used with archived video only. See Figure 10 on page 15 for more information.

8 —Click the triangle to pin the control bar to the screen, or auto-hide the bar when the cursor is moved. 

Note The control bar and audio icon will not display if your workstation monitor is set to 16-bit color setting. Change 
your monitor color setting to 32-bit.

9 Video image.

10 Camera menu. 

Right-click the image to open the menu and select an option. Options not supported by the camera are disabled (shown 
in gray). See the “Using the Pop-Up Menu” section on page 31 for more information.

11  Control icons.

 • —Audio. The audio icon appears if the camera supports audio. Click to enable  or mute  live audio 
volume. This control does not affect recorded video.

 • —Privacy Mask. Click to enable  or disable  the Privacy Mask. See the “Using the Privacy Mask” 
section on page 34.

 • —PTZ. Click to enable  or disable  the Pan, Tilt and Zoom (PTZ) controls. See the “Using Pan, Tilt, and 
Zoom (PTZ) Controls” section on page 42.

 • — See the “Synchronizing Video Playback in Multiple Panes” section on page 38.

Note The control bar and audio icon will not display if your workstation monitor is set to 16-bit color setting. Change 
your monitor color setting to 32-bit.
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Controlling Live and Recorded Video
 • Soft-deleted cameras (shown with a  icon) are cameras that were removed from the system but 
still allow access to the camera’s recorded video. You cannot display live video from soft-deleted 
cameras. 

 • The control bar and audio icon will not display if your workstation monitor is set to 16-bit color 
setting. Change your monitor color setting to 32-bit.

Additional Information

Refer to the following topics for additional options:

 • Using Record Now, page 30

 • Using the Pop-Up Menu, page 31

 • Using the Smooth Video Options When Viewing Live Video, page 37

 • Synchronizing Video Playback in Multiple Panes, page 38

 • Using Pan, Tilt, and Zoom (PTZ) Controls, page 42
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Controlling Live and Recorded Video
Viewing Recorded Video
You can view recorded video from a continuos loop, for a motion event, or from a video clip. The camera 
must be configured to support each of these options, and you must have access to a video viewing 
application that supports these functions (some applications are used for viewing only). 

For example, a camera can be configured to record the following:

 • Continuous recordings that include video from a set amount of time, such as the past 60 minutes.

 • Motion event recordings that are triggered whenever a motion event occurs. Video is recorded when 
the motion occurs, and for a configured number of seconds before and after the event. Use a video 
viewing application (such as the Cisco Video Surveillance Safety and Security Desktop) to view 
motion event video.

Figure 10 describes the main recording features and controls. 

Figure 10 Viewing Recorded Video

1 Camera Name—Source of the recorded video. 

2 Indicates the video quality, which can be affected by network and system performance. The icon turns red if the video 
quality is poor .

Note This icon is for informational purposes only when displayed with recorded video (the Smooth Video options do 
not apply). 

3 Pop-up menu options. See the “Using the Pop-Up Menu” section on page 31.

4 Timestamp for the currently displayed video image. For example: .

Note Changes to  when live video is displayed.
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Controlling Live and Recorded Video
5 Range Bar—The span of video to work with. 

 • The entire range bar represents the entire span of available recorded video. Slide the range bar selectors to shorten 
the range (see below). 

 • The lower (green) seek bar represents the selected range (see below).

6 Range Bar selectors—Drag the range bar selectors to narrow the timespan of video you want to review. 

For example, drag the selectors to create a 10 minute range. You can then drag that range left or right to the appropriate 
place in the recorded span. 

In the following example, the entire range of recorded video is selected (the range bar selectors are to the far right and 
left). To display the timestamps, click a selector. 

Click and drag the range bar selectors to choose a shorter period of time. In the following example, the range bar 
selectors are used to select approximately 10 minutes of video. Drag the selected range left or right to locate the desired 
range of recorded video. 

Tip The green seek bar represents the selected span. If the span in the top range bar is 10 minutes, then the green 
seek bar represents 10 minutes of video. Slide the seek bar selector to choose the playback time (see below).

Tip Double-click a range bar selector to playback the video from the beginning of that range.

7 Seek Bar —Represents the video range, and is used to select a playback time.

For example, if the range is 10 minutes, then the seek bar represents 10 minutes of video.

Tip Right-click the seek bar and select Seek to... to select a specific date and time.

Note Gaps in the recorded video are shown in gray. Recording gaps occur if there is a manually-triggered Record 
Now session, if recording was manually stopped, if recording was stopped by a schedule, or if video was 
unavailable due to network connectivity issues, device malfunctions, or other events.

8 Seek Bar selector—Drag the selector to play video from the selected time (as indicated by the timestamp).

Note When you move the scroll bar for a video pane that is synchronized, that pane becomes the new synchronization 
master pane. The other synchronized panes play video according to the master pane. See the “Synchronizing 
Video Playback in Multiple Panes” section on page 38.
16
Monitoring Video Using the Cisco Video Surveillance Operations Manager, Release 7.5

OL-31739-01



 

Controlling Live and Recorded Video
9 Bookmarks—Create bookmarks to save a video clip or a repeating segment (see below). 

To create a bookmark, Ctrl-Click-drag the seek bar. The bookmark span is shown in orange. 

10 Bookmarks menu—Right-click the seek bar to display the bookmark menu. You can save the bookmarked video as a 
clip in one of the supported formats, remove all bookmarks, or create a repeating segment.

See the following for more information:

 • Managing Video Clips, page 19

 • Creating a Repeat Segment, page 29

11 Indicates live or recorded video. Click the icon to switch between live and recorded video. 

 • —Live video is displayed.

 • —Recorded video is displayed.

Tip The first time you select a camera’s recorded video, the playback begins slightly behind the live (current) time. 
When you toggle between live and recorded, recorded video returns to the previously selected timestamp.

12 Recorded video playback controls.

 • —Step Reverse button—(Archived video only) Pauses the playback and steps back one frame at a time.

 • —Play Reverse button—(Archived video only) Plays the video archive in reverse at normal speed.

 • —Pause button—Pause the video playback.

 • —Play Forward button—Play the video forward at normal speed.

 • —Step Forward button—(Archived video only) Pauses the playback and steps forward one frame at a time. 

Variable Speed Playback

Right-click the Play Reverse  or Play Forward  button to play the video slower or faster. 

For example, select 0.50X to play the video at half speed (forward or reverse). Select 4.00X to play at 4 times the normal 
rate (forward or reverse).
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Controlling Live and Recorded Video
Usage Notes

 • Multi-pane video clips can also be saved to your desktop and played using the Cisco Video 
Surveillance Review Player. 

 • If the Record Now feature is enabled, right-click the image and choose Record Now to record live 
video. 

 • If a camera is soft-deleted, you can still access the camera’s recorded video but cannot display live 
video. Recordings are retained on the system until removed according to the recording retention 
settings.

 • Click the  icon to toggle between live and recorded video. The  icon appears when recorded 
video is displayed. 

 • The first time you select a camera’s recorded video, the playback begins slightly behind the live 
(current) time. When you toggle between live and recorded, recorded video returns to the previously 
selected timestamp.

 • To maximize the video screens, move the new workspace to a separate monitor and double-click a 
pane to fill the entire browser window. To fill the entire monitor screen, right-click the image and 
select Full screen mode. 

 • To control the playback in multiple video panes, press Shift-Click to select multiple concurrent 
panes, or Ctrl-Click to select individual panes. The borders of all selected panes turn to orange. 
Controls and actions performed in one pane also affect the other selected panes. To deselect panes, 
select a single pane, or use Shift-Click or Ctrl-Click to deselect the panes.

13 —Click the triangle to pin the control bar to the screen, or auto-hide it when the cursor is moved. 

Note The control bar and audio icon will not display if your workstation monitor is set to 16-bit color setting. Change 
your monitor color setting to 32-bit.

14 Camera feature icons. For example:

 •  or —Audio is supported by the camera and enabled or disabled in the viewing pane.

 • —The synchronization icon appears in video panes that play synchronized video. See the “Synchronizing Video 
Playback in Multiple Panes” section on page 38.

Note The PTZ icons are enabled only for live video.

Note The control bar and audio icon will not display if your workstation monitor is set to 16-bit color setting. Change 
your monitor color setting to 32-bit.
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Controlling Live and Recorded Video
Managing Video Clips
Video clips can be created as a file for download and playback from a PC workstation, or as a Virtual 
Clip that can be streamed directly from a monitoring application (such as the Cisco VSM Operations 
Manager or Cisco SASD applications). See “Clipping Support By Application” for the clip formats 
supported by each application in this release.

Refer to the following topics for more information:

 • Clipping Support By Application, page 19

 • Supported File Formats And Playback Options, page 20

 • Creating Video Clips, page 22

 • Downloading and Viewing Clips, page 27

Tip • You can also search for and download clips using the Clip Search feature in Operations 
Manager/Cisco VSM Federator and the Clip Management feature in Cisco SASD/Cisco SASD 
Federator.

 • Timestamps are not displayed in 3rd-party video viewers. use the Cisco Review Player to play video 
clips that display timestamps (see the Cisco Video Surveillance Review Player User Guide for more 
information).

Clipping Support By Application

You can create and view video clips using the following Cisco VSM applications:

Table 2 Video Clip Support

Application
Create 
MP4 Clips

Create 
CVA Clips

Create 
Virtual Clips

View 
MP4 Clips1

1. MP4 clips are saved to the server and play immediately after being downloaded to the monitoring PC. Third-party video players (such as VLC) can also 
be used to view MP4 clips.

View 
CVA Clips 

View 
Virtual Clips

Clip Search 
Feature

Cisco VSM 
Operations Manager

Yes Yes Yes Yes No Yes Yes

Cisco VSM Federator Yes2

2. Create MP4 clips using the Federator Thumbnail Search.

Yes No Yes3

3. Federator clips must be downloaded and played using either Cisco Review Player or VLC.

No Yes4

4. Double click the virtual clip in Federator Clip Search to play the virtual clip.

Yes

Cisco SASD Yes Yes Yes5

5. Thumbnail Search supports MP4 clip creation only.

Yes No No Yes6

6. Cisco SASD does not support Virtual Clip search in this release.

Cisco SASD 
Federator

Yes7

7. Create MP4 clips using the Federator Thumbnail Search.

Yes No Yes8

8. Federator clips must be downloaded and played using either Cisco Review Player or VLC.

No No Yes9

9. Cisco SASD Federator supports MP4 clips only in this release (virtual clip search is not supported).

Cisco VSM Review 
Player

No No No Yes Yes10 No No
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Controlling Live and Recorded Video
Supported File Formats And Playback Options

Video clips can be created in multiple formats:

 • MP4 and CVA video files can be saved to a local disk for playback using the Cisco VSM Review 
Player or a third party player.

 • Virtual clips can be stored on the Cisco VSM server for playback using supported applications, such 
as the browser-based Operations Manager.

10. CVA files can only be opened in applications that support the CVA format (such as the Cisco Review Player).
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Controlling Live and Recorded Video
Table 3 describes the video clip options:

Table 3 Video Clip File Formats 

File Format Description

Virtual clip Defines a segment of video on the Cisco VSM server for playback using a supported application, such as 
the browser-based Operations Manager.

Notes

 • In this release, Virtual Clips can be created using the Operations Manager and Cisco SASD, but not 
Cisco VSM Federator or Cisco SASD Federator. See the “Clipping Support By Application” section 
on page 19.

 • Virtual clips can be any length. There is no maximum duration for a virtual clip.

 • Virtual clips can be saved as an MP4 file (the 10 hour MP4 limitation applies).

 • Virtual clips do not support audio recording.

MP4 MP4 clips are saved on the server and can be downloaded to a PC workstation or local disk.

MP4 clips support a single video pane and can include audio (CVA/CVX files do not support audio). 

MP4 is a standard video file format that is playable on most computers and useful for sending to 3rd parties.

Notes

 • In this release, MP4 clips can be created using the Operations Manager and Cisco SASD. To create 
MP4 clips using the Cisco VSM Federator or Cisco SASD Federator, use the Clip Search and Clip 
Management features. See the “Clipping Support By Application” section on page 19.

 • MP4 clips play automatically in the pane when downloaded. The clips can also be viewed using the 
Cisco VSM Review Player or VLC media player.

 • You can also use the Clip Search feature to view, download and delete MP4 clips saved to the server. 

 • The maximum duration for an MP4 clip is 10 hours per clip.

 • MP4 clips require that the clipping repository be selected on the Media Server associated with the 
camera. See the “Partition Settings” section on page 5.

 • MP4 clips are saved on the server for 7 days and are automatically deleted from the server 7 days after 
creation. To download the clips to a local drive, use the Get Clips Status menu (see also the 
“Downloading and Viewing Clips” section on page 27).

 • MP4 audio playback is supported only with the Cisco VSM Review Player or VLC media player.

 • Up to five MP4 clips can be created at a time per Media Server. If the limit is reached, wait for a clip 
to complete before creating a new one. 

 • Users can only delete their own clips. Users that belong to a User Group with Camera permissions can 
also delete other users’ clips.

 • If the clipping fails, see your system administrator for assistance.

 • Use the Cisco VSM Review Player to save MP4 files in the tamper proof MPX format. See the Cisco 
Video Surveillance Review Player User Guide for more information.
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Controlling Live and Recorded Video
Tip You can also right-click a video pane and select Take Snapshot to save a still image in BMP, 
JPEG, PNG, and TIFF formats. See the “Using the Pop-Up Menu” section on page 31 for more 
information.

Creating Video Clips

To create a video clip, create a bookmark span and select the clip format, as described in the following 
procedure. 

Requirements

 • You must belong to a User Group with Export Recordings permissions to create, view or download 
video clips.

 • The Media Server hard disk volume must have sufficient disk space to create the video clip or the 
operation will fail. See your system administrator for more information.

File Formats Supported by the Monitoring Applications

Review the “Clipping Support By Application” section on page 19 for information on the clip formats 
supported by each appliaction in this release.

Procedure

Step 1 Select a video pane from the viewing application (such as Cisco SASD or Operations Manager).

Tip To create a multi-pane clip in the CVA format, press Shift-Click to select multiple concurrent 
panes, or Ctrl-Click to select individual panes.

Step 2 In the green seek bar, Ctrl-Click and drag the mouse cursor to create a bookmark span. The bookmark 
span is shown in orange (Figure 11). 

CVA A Cisco video archive (CVA) can include multiple video panes that synchronize to the same time. 
CVA/CVX clips are downloaded immediately and not stored on the server.

CVA files can only be opened in applications that support the CVA format (such as the Cisco Review 
Player). 

Notes

 • The maximum duration for a CVA clip is 24 hours per clip.

 • CVA files do not support audio playback.

CVX A tamper proof CVA file. CVX files require a password that is entered when the file is created. You must 
enter the password to open and view the video file. 

Notes

 • CVX video playback will shut down if the file is tampered with. 

 • CVX files do not support audio.

Table 3 Video Clip File Formats (continued)

File Format Description
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Tip In recording mode , you can also right-click the image and choose Select Clip Range from the 
pop-up menu (see the “Using the Pop-Up Menu” section on page 31). A 10 minute clip range is 
automatically selected starting from current thumb position, and the range bar is automatically scaled to 
1 hour.

Step 3 Right-click the bookmark and select an option to create a MP4, CVA or virtual clip (Figure 11). 

Figure 11 Creating a Video Clip
.

Tip See “Clipping Support By Application” for the file formats supported by each Cisco monitoring 
application in this release.

Step 4 Save the file:

CVA/CVX files 

a. (Optional) Revise the start and end date and time (Figure 12). Enter a time between 30 seconds and 
24 hours (the range cannot include more than one codec and the start time must be before the end 
time). 

Tip Use the Set Duration field to enter a specific length of time for the clip. The duration begins at 
the beginning bookmark time.
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Figure 12 CVA Clip Settings

b. (Optional) Select Enable tamper proof and enter a password to create a password-protected CVX 
file (Figure 12). 

c. Click OK.

d. Select a location on a local disk and click Save.

e. Wait for the clip to be generated and downloaded. Video streaming is paused during CVA/CVX clip 
generation.

f. Play the clip using a video player such as the Cisco Review Player. 

MP4 clips

a. (Optional) Revise the start and end date and time (Figure 13). Enter a time between 30 seconds and 
10 hours (the range cannot include more than one codec and the start time must be before the end 
time). 

Tip Use the Set Duration field to enter a specific length of time for the clip. The duration begins at 
the beginning bookmark time.
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Figure 13 MP4 Clip Settings

b. (Optional) Enter a clip name that identifies the recording on the server (Figure 13). For example, if 
you enter “My 4500 Camera” then the clip selection will be “My 4500 Camera”. The default name 
is “My Clip”. 

c. (Optional) Select or deselect Record Audio (if the camera supports audio recordings) to include or 
exclude audio. Audio playback is supported only with the Cisco VSM Review Player or VLC media 
player.

d. Click OK to save the clip to the server.

Tip Right click the image and select Get clip status to view the current status: In-Progress, 
Completed or Failed. Use the Clip Search option to view, download, delete and manage MP4 
clips saved on the server.

e. Download and play the clip as described in the “Downloading and Viewing Clips” section on 
page 27.

Virtual clips

a. (Optional) Revise the start and end date and time (Figure 14). (the range cannot include more than 
one codec and the start time must be before the end time). 

Tip Use the Set Duration field to enter a specific length of time for the clip. The duration begins at 
the beginning bookmark time.
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Figure 14 Virtual Clip Settings

b. (Optional) Enter a clip name that identifies the recording on the server (Figure 14). For example, if 
you enter “My 4500 Camera” then the clip selection will be “My 4500 Camera”. If blank, the default 
name is “My Clip”. 

c. Click OK to save the clip to the server.

Tip Right click the image and select Get clip status to view the current status: In-Progress, 
Completed or Failed. Use the Clip Search option to view, download, delete and manage MP4 
clips saved on the server.

Step 5 Download and play the clip as described in the “Downloading and Viewing Clips” section on page 27.
26
Monitoring Video Using the Cisco Video Surveillance Operations Manager, Release 7.5

OL-31739-01



 

Controlling Live and Recorded Video
Downloading and Viewing Clips

Video clip formats are accessed and played in the following ways:

Tip See “Clipping Support By Application” for the file formats supported by each Cisco monitoring 
application in this release.

Procedure

Step 1 Right-click the video pane and choose Get Clip Status (Figure 15). 

Step 2 Select the Clip name.

 • “Local” clips are MP4 clips that must be downloaded to a local disk.

 • “Streamable” clips are virtual clips that can be streamed in the video pane without being 
downloaded.

Table 4 Video Clip Download Options

Clip Format Download Options

CVA clips Downloaded when they are created. Play CVA clips using a supported video player, such as the Cisco 
Review Player. 

MP4 Clips Right-click the video pane and select Get Clip Status (not supported in Federator in this release). 
Select the clip name from the list and save the file to a local disk (the clip remains on the server for 
7 days after it was created). 

 • The clip automatically plays in the video pane when the download is complete. 

 • You can also play the clip using a supported video player such as the Cisco Review Player or 
VLC. 

 • You can also search for and download MP4 clips using the Clip Search feature in Operations 
Manager or the Clip Management feature in Cisco SASD.

Virtual Clips Right-click the video pane and select Get Clip Status (not supported in Federator in this release).

Select the clip name from the list to play the clip in the video pane. 

To download the clip, use the Clip Search feature and select the Virtual Clip Search tab (if 
supported by your monitoring application).
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Figure 15 Accessing a MP4 Clip

Note Clips are automatically deleted from the server after 7 days.

Step 3 (Virtual Clips) The clip plays in the video pane when selected.

Step 4 (MP4 clips only) Enter a file name and location, click Save, and wait for the clip to download. The clip 
will automatically play in the pane the fist time it is downloaded. 
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Creating a Repeat Segment
A repeating segment is a range selected on a recording that plays continuously in a loop. When the end 
of the segment is reached, playback starts over from the beginning of the segment. The video segment 
loops indefinitely until you cancel the segment or seek video outside the selected range (seeking inside 
the selected range does not cancel the segment). 

Figure 16 Create a Repeating Segment

Note Repeating segments are used with recordings only.

Procedure

Step 1 Ctrl-Click-drag the seek bar in a recording to create a bookmark (Figure 16).

The bookmark span is shown in orange.

Step 2 Right-click the seek bar and select as a repeat segment.

Step 3 (Optional) Enter a specific start and end date and time.

Step 4 To cancel the segment, right click the segment and choose Remove all Bookmarks.

You can also click on the seek bar outside the selected range.
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Using Record Now
To manually trigger recording of a live video stream, right-click the image and choose Record Now. 

Requirements

 • The Record Now option must be enabled for the camera configuration in the Operations Manager.

 • Your use account must include access permissions to view recorded video.

 • You can record video from the live primary video stream only.

Usage Notes

 • Audio is not recorded.

 • Video is recorded for a system-defined length of time (the default is 5 minutes).

 • The recording is retained on the system according to the event retention settings for the camera. For 
example, if the camera’s event recordings are retained for 30 days, then the Record Now recordings 
will also be available for 30 days. When the retention time is exceeded, the recording is 
automatically deleted (see the “Managing Video Clips” section on page 19 to save the video to a 
separate file). 

Procedure

Step 1 Log in to the video viewing application and select a camera.

Step 2 Choose live video  (see the “Viewing Live Video” section on page 12).

Step 3 Right click the image and choose Record Now (Figure 17).

 • The recording is performed in the background. You can continue to use the other playback controls.

 • The recording status is displayed in red text (Figure 17) when the recording time nearly complete.

Figure 17 Record Now
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Step 4 To view the recorded video, review the following notes.

 • Record Now clips are available from the primary stream only. Right click the image and choose 
Select Streams and Clips to view the recorded primary stream (disabled if the pane is 
synchronized).

 • If the video is within the time span of other recorded video, there is no separate indication of the 
Record Now video. You can access the video as described in the “Viewing Recorded Video” section 
on page 15).

 • If the Record Now video is older than the continuous loop, the gap between the recording times is 
shown in gray:

Note When the event retention time is exceeded, the Record Now recording is automatically deleted. 
To save the recording, see the “Managing Video Clips” section on page 19.

Using the Pop-Up Menu
Select a video pane and right-click on the image to open a menu with the following options (see Figure 9 
on page 12).

Table 5 Camera Pop-Up Menu (Right-Click the Video Image) 

Camera Menu Item Description

Pan, Tilt, and Zoom (Live video only) Open the PTZ preset list that allows you to quickly adjust the camera view.

See the “Using Pan, Tilt, and Zoom (PTZ) Controls” section on page 42

Digital zoom Digitally enlarges the image to zoom in on a specific area. 

Double click the enlarged image to use a window-in window view. Adjust the viewing area in 
the small window to define the portion of enlarged video to display.
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Sync selected panes with 
this pane

Synchronizes the playback from multiple video panes to the same time.

 • After a pane is synchronized, the menu item changes to Remove this pane from sync. 

 • To synchronize additional panes, right-click an un-synchronized pane and select Add 
selected panes to sync.

See the “Synchronizing Video Playback in Multiple Panes” section on page 38.

Full screen mode Enlarges the video image to fill the entire monitor screen.

Tip To exit, press Esc, or right-click and choose Full screen mode again.

Take snapshot Saves a snapshot of a single video pane (excluding control icons, timestamps and other 
information) in BMP, JPEG, PNG, or TIFF format. 

Take composite snapshot Saves a snapshot of all panes in a multi-pane layout (including control icons, timestamps and 
other information) in BMP, JPEG, PNG, or TIFF format.

Record now (Live video only) Immediately begins recording video.

See the “Using Record Now” section on page 30 for more information.

Note The Record Now option must be enabled in the camera configuration. 

Audio settings (Cameras with audio support only). Opens a window used to adjust video playback volume and 
balance.

Smooth video settings (Live video only) Creates a smooth video playback if the playback is choppy or delayed due 
to network or other performance issues. 

See the “Using the Smooth Video Options When Viewing Live Video” section on page 37.

Global settings Provides settings that apply to all video panes. For example: UI transparency and zoom video 
to fit the pane.

Select Streams Allows you to select the live and recorded video streams (primary or secondary) supported by 
the camera.

Note Select Streams is disabled when the pane is synchronized. See the “Synchronizing 
Video Playback in Multiple Panes” section on page 38 for more information.

Select clip range (Archive video only) Selects a 10 minute clip range starting from current thumb position. The 
range bar is automatically scaled to 1 hour.

See the “Managing Video Clips” section on page 19 for more information.

Get clip status Shows the current status of MP4 and virtual clips: In-Progress, Completed or Failed.

Select a clip name to view the clip. MP4 clips are downloaded to a local disk (you are prompted 
to enter a filename and location.

See the “Creating Video Clips” section on page 22 for more information.

Table 5 Camera Pop-Up Menu (Right-Click the Video Image) (continued)

Camera Menu Item Description
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Understanding Video Pane Border Colors
The color that surrounds a video pane indicates the status of the video in that pane. For example, when 
you click anywhere in a video pane, the pane becomes active and the border changes to orange. The 
controls and actions performed apply to the active pane. 

Table 6 describes the meaning of each color.

Table 6 Video Pane Border Colors 

Color Description

Gray The pane is not highlighted. All panes have a gray border by default.

Orange The pane is selected as the active pane, and the controls and actions apply to 
that pane. If multiple panes are selected as active panes, the controls and 
actions performed on one pane apply to all active panes. 
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Using the Privacy Mask
When the Privacy Mask is enabled on a compatible camera (Figure 18), all live video from that camera 
is blocked and cannot be viewed by any operator or monitor, or recorded by the Cisco Video Surveillance 
system. This feature is typically used with the “Virtual Sitter” feature for health care providers, allowing 
operators to temporarily block video from a Cisco Video Surveillance camera when the patient requires 
privacy. Figure 18 shows the icons used to enable or disable the Privacy Mask.

Note You must belong to a User Group with Control Privacy Mask access permissions to use this feature. 

Figure 18 Privacy Mask Controls

Icon Purpose Description

Enable the Privacy Mask Click  to block the camera’s entire field of view and display a blank (blue) screen.

 • Live video is not transmitted and cannot be viewed by any workstation or monitor. 

 • Recorded video displays the blank (blue) or flashing screen. 

 • A “Privacy Mask Timer” causes the screen to flash after a period of time, which 
reminds the operator to disable the Privacy Mask. The default timer is 15 minutes 
and can be modified using the Operations Manager (System Settings > Settings 
> Privacy Mask Timer). 

Note The Privacy Mask is not disabled automatically; an operator must disable the 
Privacy Mask by clicking the  icon to allow live video to be transmitted, 
viewed and (optionally) recorded. 

Disable the Privacy Mask 
(Default)

Click  to enable normal video streaming, monitoring, and recording.
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For example, when the Privacy Mask is enabled , the video frame for that camera is blank 
(Figure 19). The same blank (blue) screen is recorded (if recording is configured).

Figure 19 Privacy Mask Enabled

When the Privacy Mask Timer expires, the video frame flashes to remind the operator that the mask is 
still on. To display video, click  to disable the Privacy Mask.

Note If the camera reboots due to a power cycle or other reason, the camera will power up with the Privacy 
Mask in the state it was before the reboot. For example, if the mask was enabled and there was 5 minutes 
remaining on the timer, the camera will remember the state after the reboot.

Related Information

Supported cameras can also be configured with “Privacy Zones” that block portions of the video image 
at all times, even if the Privacy Mask is disabled. See the camera documentation for instructions to define 
Privacy Zones.

For more information about Cisco Virtual Patient Observation, see the following:

 • White Paper—Virtual Patient Observation: Centralize Monitoring of High-Risk Patients with Video.

 • At-A -Glance Overview—Benefits of Virtual Patient Observation.

 • Ten Use Cases—Real-life scenarios for using video surveillance in hospitals.

 • Solution Blog Post—New Solution: Cisco Virtual Patient Observation.
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Cameras that Support the Privacy Mask

The Cisco cameras that support the Privacy Mask include the following:

 • CIVS-IPC-2830

 • CIVS-IPC-2835

 • CIVS-IPC-3421V

 • CIVS-IPC-3520

 • CIVS-IPC-3530

 • CIVS-IPC-3535

 • CIVS-IPC-6000P

 • CIVS-IPC-6020

 • CIVS-IPC-6030

 • CIVS-IPC-6050 

 • CIVS-IPC-6930

 • CIVS-IPC-7030
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Using the Smooth Video Options When Viewing Live Video 
If live video playback is choppy due to network or other performance issues, use the Smooth video 
settings to automatically do the following:

 • Create a video data buffer (in seconds) that delays live playback while video data is cached. Live 
video can then be played back smoothly despite network delays between the camera, Media Server, 
and workstation.

 • Automatically switch to a different stream if the live video quality is poor.

Icon Colors

The video quality icons in each pane indicate the following:

 • Green  indicates everything is fine. 

 • Yellow  indicates that the client workstation has detected the play back is not smooth. 

 • Red  indicates a severe adverse situation. Action will be taken to correct the situation, such as 
switching to secondary stream or iFrame streaming. 

Usage Notes

 • The Smooth Video Options are available only for live video on non-PTZ cameras (the Smooth Video 
Options are automatically disabled on PTZ cameras).

 • The settings are applied to all non-PTZ cameras and are persistent for the current PC workstation. 
For example, the settings will remain if you log out and back in, or view a different camera and then 
return to the current camera.

 • The settings also apply to the non-PTZ cameras when using the Cisco Safety and Security Desktop 
(SASD) application and the Cisco Video Surveillance Management Console.

 • The Smooth Video options are disabled if you manually select a stream (right-click a video pane and 
choose Select Streams and Clips). The pane will display the selected stream even if the video 
quality is poor (the video will not automatically switch to the Smooth Video alternative stream). To 
cancel the manually selected stream and re-enable the Smooth Video settings, reload the view or 
drag and drop the camera again.

 • If a video stream is selected from a redundant media server, the Smooth Video option is disabled 
(the camera will not use a secondary stream even if the video quality icon is red).

Procedure

Step 1 Right-click a live video image to open the pop-up menu.

Step 2 Select or deselect Enable Smooth Video for Live non-PTZ Camera to enable the smooth video 
options. 

Step 3 (Optional) Enter the Preroll Buffer Size in Seconds to define the number of seconds that live video will 
be delayed. 

Video data is saved in a cache on your PC to avoid pauses caused by network bandwidth and other issues. 
We recommend a value between 1.5 and 3 seconds. 
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Caution We strongly recommend that the Preroll Buffer be disabled (enter 0 or leave the field blank) since 
streaming delays can cause a potential security risk. We recommend that you address the network 
bandwidth or performance issues causing the delays. Use the Preroll Buffer only when significant 
stuttering occurs and a network resolution is not available. 

Step 4 Use the Smooth Video Options to define an alternative video stream that will be used if video quality 
is poor despite the smooth video buffer (video quality is indicated by the  icon on the live viewing 
pane).

 • Secondary Stream—(Only if configured on the camera) If the live video quality is poor , the 
secondary video stream is used. Secondary streams typically present a lower-quality image that 
requires less bandwidth and processing.

 • I frame only—If the live video quality is poor , then only the iFrame video is displayed. iFrame 
video reduces the bandwidth requirement to correct the situation.

 • None—If the live video quality is poor , no change is made and the selected stream is displayed 
even if it results in choppy or paused playback.

Note • These options are not used if the video quality is acceptable  or if the icon is yellow 
(intermediate) . The selected stream is displayed normally. 

 • A down arrow  is displayed when the secondary or iFrame stream is applied.

 • If an alternative stream is applied, the settings remain until you close and reopen the video source 
(camera).

Synchronizing Video Playback in Multiple Panes
To synchronize video playback from multiple panes, select multiple panes, right-click the pane that 
defines the master time, and choose Sync Selected Panes With This Pane. All panes will play video 
from the same date and time. 

Usage Notes

 • All panes will play forward when synchronization begins, even if one or more of the panes was 
playing in reverse.

 • Synchronization for recorded video is performed only if the time in the selected panes overlap. If 
the time for a video pane does not overlap with the master pane, the pane is excluded from 
synchronization.

 • When you move the scroll bar for a video pane that is synchronized, that pane becomes the new 
synchronization master pane. The other synchronized panes play video according to the new master 
pane. 

 • If the seek controls are used to search video, the other synchronized panes pause until the seek 
completes, then continue to display video that is synchronized with the new master pane time. 

 • You can switch the synchronized panes between live and recorded video.
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 • To remove a pane from the synchronized playback, right-click the pane and choose Remove This 
Pane From Sync to remove it.

 • To add un-synchronized panes, right-click the pane and choose Add selected panes to sync.

 • The Select Streams and Clips menu item is disabled when a pane is synchronized.

 • When 16 video panes are synchronized, some live video panes may appear to be not synchronized 
if the video stream is configured for the following: 

Format Resolution Framerate

JPEG 640x480 30 fps

H-264 1920x1080 30 fps
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Figure 20 describes the main synchronization attributes.

Figure 20 Synchronized Playback of Recorded Video

Procedure

To play recorded video from multiple video panes synchronized to the same time, do the following:

Step 1 Select a layout or pre-defined view from the View menu. 

Step 2 Shift-click or Control-click to select multiple video panes for synchronization.

The selected panes are displayed with a light yellow border.

1 —The synchronization icon appears in the video panes that display synchronized video.

2 The timestamp for synchronized video is the same.

3 Roll over a synchronized pane to display the playback controls. Changes to any pane are mirrored by the other 
panes.

4 Unsynchronized panes can continue to display live or recorded video. 

To add a pane to the synchronized group, right-click the pane and select Add selected panes to sync.
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Step 3 Right-click a video pane and select Sync Selected Panes With This Pane from the menu.

The selected pane becomes the master pane.

Step 4 (Optional) To remove a pane from the synchronized group, right-click the pane and choose Remove This 
Pane From Sync.

Note The pane continues to play video from the same timestamp, but the video can be stopped or 
altered without affecting the other panes. 

Step 5 (Optional) To add un-synchronized panes, right-click the pane and choose Add selected panes to sync.
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Using Pan, Tilt, and Zoom (PTZ) Controls
Cameras that support pan, tilt and zoom (PTZ) movements display a PTZ icon . Click the icon to 
enable PTZ (the icon is blue when enabled, and do one of the following: 

 • To pan and tilt,Hold down the left mouse button while dragging the mouse ( ) right, left, up and 
down. 

 • To zoom:

 – Hold down the left mouse button and use the scroll wheel to zoom in and out.

or

 – Hold down the Shift key and then press the left mouse button. Drag the mouse up or down to 
zoom.

In addition, PTZ presets allow the camera to quickly jump to a preset position. For example, a PTZ preset 
could zoom in on a doorway, or pan to the opposite end of a parking lot. PTZ presets can be triggered 
using a mouse, joystick or automatically triggered event. 

Cameras can also be configured with PTZ tours that automatically cycle between PTZ preset positions. 
You can interrupt the tour using the PTZ controls, and the tour will resume after a set amount of time. 
See your system administrator for more information.

Figure 21 summarizes the controls and information available on each PTZ camera viewing pane.

Figure 21 Camera PTZ Controls

1 Selected Camera 3 PTZ Enabled/Disabled Icon (click to toggle).

 • Blue—Enabled

 • Grey—Disabled

2 PTZ is available in Live mode only 4 PTZ Preset Menu (right-click to access)
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Usage Notes

 • To use a USB joystick, see the “Calibrating a Joystick for Windows 7” section on page 44.

 • PTZ movements are available only when viewing live video. 

 • PTZ can only be enabled for a single video pane if multiple panes are displayed. See the “Using PTZ 
Controls When Multiple Video Windows are Displayed” section on page 45. 

 • You must also belong to a user group with Perform PTZ permissions.

 • PTZ commands are available only if the primary Media Server is functional. If the Primary server 
goes down, or is not available on the network, PTZ commands will not function even if video is still 
being delivered by a redundant server (if configured). See the “High Availability” section on page 1 
for more information.

PTZ Control Procedure

To control a camera’s PTZ movement or trigger a PTZ preset position, do the following:

Step 1 Display the live video from a PTZ-enabled camera:

a. Click Monitor Video. 

b. Expand the location tree and select the camera.

c. Highlight a video pane and double-click a camera name.

Step 2 Click the PTZ control icon to enable PTZ:

 • —(Blue) PTZ controls are supported by the camera and enabled in the viewing pane.

 • —(Grey) PTZ controls are disabled. Click the  icon to enable PTZ controls.

Note If a higher-priority user is using the PTZ controls, the PTZ controls remain locked and you 
cannot control the PTZ movements until released by the higher priority user. 

Step 3 To move the camera position, use the following controls. 

Using a Mouse

 • Pan and Tilt—Hold down the left mouse button while dragging the mouse ( ) right, left, up and 
down.

 • Zoom—

 – Hold down the left mouse button and use the scroll wheel to zoom in and out.

or

 – Hold down the Shift key and then press the left mouse button. Drag the mouse up or down to 
zoom.

Using a USB Joystick

 • Pan—move the joystick bar horizontally.

 • Tilt— move the joystick bar vertically.

 • Zoom —twist the joystick.

Tip See the “Calibrating a Joystick for Windows 7” section on page 44 for information to set up a 
USB joystick for the first time.
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Step 4 (Optional) Select a PTZ preset position.

Using a Mouse

 – Right-click the image and choose Pan, Tilt, and Zoom > Presets (Figure 21). 

 – Choose a preset to move the camera to the defined position.

Using a USB Joystick

 – Press the joystick button that corresponds to the PTZ preset number. 

 – For example, joystick button 1 triggers PTZ preset 1, joystick button 2 triggers PTZ preset 2, 
etc.

Calibrating a Joystick for Windows 7

To use a USB joystick to control PTZ camera movements, connect the joystick to a USB port on the 
client PC and calibrate the device for Window 7. You can use the software and instructions included with 
the joystick, or use the built-in Windows calibration utility, as described in the following procedure.

Procedure

Step 1 Install and configure the USB joystick according to the manufacturer instructions.

 • See the device documentation for more information. 

 • The manufacturer may also include a calibration utility that can be used instead of the built-in 
Windows utility.

Step 2 In Windows 7, calibrate the device using the Game Controllers control panel.

a. Select Control Panel from the Start menu.

b. Select Hardware and Sound.

c. Select Devices and Printers.

d. Double-click Game Controllers.

e. Highlight the joystick device and click Properties.

f. Click Calibrate in the pop-up window.

g. Follow the on-screen instructions to complete the process.

Tip You can also use the Windows search function: choose Search from the Start menu and enter “set up 
USB game controllers” to open the Game Controllers control panel. Highlight the joystick icon and click 
Calibrate. Follow the on-screen instructions to complete the process.

Step 3 Click Finish or OK to close the windows.
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Using PTZ Controls When Multiple Video Windows are Displayed

When multiple viewing panes are displayed, only a single pane can have PTZ controls enabled at a time 
(Figure 22). This prevents a USB joystick from affecting more than one pane. 

 • The pane with PTZ enabled displays a  icon. The  icon indicates that PTZ controls are 
disabled. 

 • Click the disabled icon  to enable the controls for a pane (and disable the controls for the other 
panes). 

 • If a pane does not display an icon, then the camera does not support PTZ movements.

Figure 22 PTZ Controls in a Multi-Pane View

Note PTZ movements are available only when viewing live video.

Tip If multiple browser windows are used to display video, joystick PTZ commands will affect the enabled 
PTZ pane in each browser window. 

1 PTZ enabled viewing pane 3 PTZ not supported by camera (no icon)

2 PTZ disabled viewing pane
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Viewing a Thumbnail Summary of Video Archives 
Use Thumbnail Search to quickly locate specific scenes or events in recorded video. Thumbnails are an 
alternative way to search through recorded video without fast-forwarding or rewinding. Figure 23 
provides an overview of the search and display controls. See the “Using Thumbnail Search” section on 
page 48 for step-by-step instructions.

Figure 23 Thumbnail Window

1 Selected 
Camera

Select a location and double-click a camera name to display a thumbnail summary of recorded video for 
the camera. 

Note Cisco VSM Federator locations are “Regions” that are linked to an Operations Manager location. 

 • Use the Recordings menu to select a camera stream.

 • Cameras are displayed as tabs along the top of the window. Double-click multiple cameras to open a 
tab for each camera.

 • Double-click an archive to play video in an Archive Player tab.

2 Skip back Skip back by the Duration time increment (see #7). This icon is disabled if the entire archive is selected.

3 Archive start 
time

The start date and time for the entire video archive.

See #4 to select a new start time, or right-click a thumbnail and choose Set Start.
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4 Set Start 
Time

The start date and time for the first thumbnail (in the top left corner of the window pane). To change the 
start thumbnail, select a new date and time and click Set Start.

Tip You can also select a thumbnail image and select Actions > Set Start to set the start time to a 
specific thumbnail (or right-click the thumbnail image and select Set Start).

5 Timeline Timeline representing the entire video archive.

6 Start time 
slider

The slider represents the Duration setting relative to the length of the entire archive. If the Duration 
setting is for the entire archive, the black slider covers the entire time line and cannot be moved.

To use the slider, choose a Duration that is less than the entire archive time and drag the slider to a 
different start time (the time is displayed above the slider). Release the mouse button to choose the new 
time.

7 Duration Choose the time span for the displayed thumbnails. The top left thumbnail displays an image from the 
beginning of the time span and the bottom left thumbnail displays an image from the end of the time span. 
The number of thumbnails and the intervals between them depend on the size of the Forensic Search 
window and the thumbnail size that you choose from the Thumbnail Size menu.

8 Show 
Timestamp

Check this check box to show the date and time displayed at the top of each thumbnail. 

9 Archive end 
time

End date and time for the entire video archive.

10 Skip 
forward

Skip forward by the Duration time increment. 

11 Timestamp Displays the date and time for each thumbnail. Select the Show Timestamp check box to turn timestamps 
on or off.

12 Video 
thumbnails

Thumbnails are displayed for the time span that is selected in the Duration drop-down menu. Use the 
Thumbnail Size menu to display larger or smaller thumbnails. 

13 Actions 
Menu

Right click a thumbnail to select an option from the Actions menu (see #17).

14 Display 
length

The duration of the displayed thumbnails.

15 Camera tabs A tab is displayed for each selected camera. Click the Recordings menu to select an available camera 
stream or recording.

16 Archive 
Player tab

An Archive Player tab plays video when you select a thumbnail and select Actions > Play (or right-click 
a thumbnail and click Play). 
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Using Thumbnail Search

Summary Steps

To view a thumbnail summary of a camera’s recordings:

1. Select Monitor and click Thumbnail Search ( ) to open the forensic search tool in a 
separate window (Figure 23). 

2. Select a location and double-click a camera name.

3. Use the tools described in Figure 23 to locate specific video.

4. Select a different stream from the Recordings menu.

5. Double-click a thumbnail to play the video. You can also select a thumbnail and select Play from 
the Actions menu.

6. See the “Detailed Procedure” for more information.

17 Menu 
Selections

Thumbnail Size—select a smaller size to display more thumbnails for the displayed video duration. 
Select a larger size to display fewer thumbnails.

Recordings—select a video stream or recording. 

Actions—choose one of the following options:

Note You can also right-click a thumbnail to access the Actions (see #13).

 • Set Start—Sets the selected thumbnail as the first thumbnail in the range. (Tip: to select a specific 
date and time as the start time, use the menu at that appears beneath the thumbnails as described in 
#4 “Thumbnail Start Time”).

 • Play —Plays the video from the selected thumbnail in an Archive Player tab. 

 – You can also double-click a thumbnail to play video.

 – Playback begins from the start timestamp. If a start timestamp is not available, the next available 
frame is displayed. 

 • Zoom To—Set the beginning and ending thumbnail for the display. Shift-click or Ctrl-click to select 
multiple thumbnails and choose Zoom To from the Actions menu. The first frame in the selected 
thumbnails becomes the new start time. The last frame in the selected thumbnails becomes the new 
end time.

 • Zoom In—Decreases the displayed thumbnail duration to the next available duration value. If no 
frames are selected, the start time does not change. If one frame is selected, that frame becomes the 
start time. If more than one frame is selected the frame closest to the beginning of the archive 
becomes the start time.

Zoom in is not available when the minimum duration is set.

 • Zoom Out—Increases the duration of the displayed thumbnail duration to the next available duration 
value. The start time remains the same. For example, if the Duration is 3 hours, choose the Zoom Out 
option to increase the Duration to approximately 6 hours.

If the start time plus the duration would exceed the length of the archive, the start time will be 
adjusted to the archive’s end time minus the duration.

Zoom out is not available when the maximum duration is set.
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Detailed Procedure

Step 1 Click Monitor.

Step 2 Click Thumbnail Search ( ) to open the forensic search window (Figure 23).

Step 3 Select a location and double-click a camera name.

The camera name appears as a tab at the top of the thumbnail display. You can select multiple cameras 
to open multiple tabs.

Step 4 Use the controls described in Figure 23 to refine the search.

For example:

 • To change the first thumbnail in the display, select a date and time from the menu below the 
thumbnails ( ) and click Set Start. The thumbnail for the 
selected date and time is displayed in the top left corner (you can also right0click a thumbnail and 
choose Set Start).

 • Choose the Duration ( ) of the thumbnail display. For example, choose 1 Hour to 
display thumbnails for a single hour. The default is Entire Archive. 

 • Click the skip icons to skip back  or forward  by the Duration time. For example, if the 
Duration is 1 hour, click the skip buttons to skip forward or back by 1 hour.

 • Click and drag the slider  to a new start time. 

 – The slider date and time appears when the slider is selected. 

 – Release the mouse button to refresh the thumbnail display with the time displayed above the 
slider. 

Note The slider length represents the thumbnail duration relative to the entire length of the 
archive. The gray time line equals 100 percent of the archive. The black slider covers the 
entire time line if the selected Duration is Entire Archive (default).

 • Choose a Thumbnail Size to enlarge or reduce the size of each thumbnail. Larger sizes display 
fewer thumbnails, and each thumbnail represents a greater time span.

Step 5 (Optional) Further refine your search by choosing one or more thumbnails and choosing one of the 
following options in the Actions menu.

Tip You can also right-click a thumbnail to access the Actions.

 • Set Start—Sets the selected thumbnail as the first thumbnail in the range (you can also select a 
specific date and time using the Set Start menu below the thumbnail display).

 • Play —Plays the selected thumbnail video in an Archive Player tab. 

 – You can also double-click a thumbnail to play video.

 – Playback begins from the start timestamp. If a start timestamp is not available, the next available 
frame is displayed. 
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 • Zoom To—Set the beginning and ending thumbnail for the display. Shift-click or Ctrl-click to select 
multiple thumbnails and choose Zoom To from the Actions menu. The first frame in the selected 
thumbnails becomes the new start time. The last frame in the selected thumbnails becomes the new 
end time.

 • Zoom In—Decreases the displayed thumbnail duration to the next available duration value. If no 
frames are selected, the start time does not change. If one frame is selected, that frame becomes the 
start time. If more than one frame is selected the frame closest to the beginning of the archive 
becomes the start time. Zoom in is not available when the minimum duration is set. 

 • Zoom Out—Increases the duration of the displayed thumbnail duration to the next available 
duration value. The start time remains the same. For example, if the Duration is 3 hours, choose the 
Zoom Out option to increase the Duration to approximately 6 hours.

If the start time plus the duration would exceed the length of the archive, the start time is be set to 
the end of the archive minus the duration.

Zoom out is not available when the maximum duration is set.
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Clip Search
Select Clip Search from the Monitor Video window (Figure 24) to view, download and delete MP4 and 
virtual clips. 

Tip You can also create and download clips by right-clicking a video pane. See the “Downloading and 
Viewing Clips” section on page 27.

Procedure

Step 1 From the Monitor Video page, click Clip Search to open the Clip Search window (Figure 24).

Step 2 Select the clip type:

 • Clip Search tab—MP4 clips

 • Virtual Clip Search tab—Virtual clips

Figure 24 Clip Search Window

Step 3 (Cisco VSM Federator only) Select a region where the clip(s) were created. Only clips from the 
Operations Manager location mapped to that region will be displayed.

Step 4 (Optional) Use the filters to search for specific clips (Table 7):

Tip Click Search without filters to display all available clips.
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Step 5 Click Search.

Step 6 Review information about the clips.

Step 7 (Optional) To download an MP4 clip, select a clip and click Download.

Note Only a single clip can be downloaded at a time.

Note If an “HTTP 400 Bad Request” error appears, it may be due to the Internet Explorer (IE) settings. 
In IE, go to Tools > Internet Options > Advanced and select “Use HTTP 1.1”. Also deselect 
“Use HTTP 1.1 through proxy connections”. Next, click the Connections tab, choose the LAN 
settings button and select “Automatically detect settings”.

a. Click Continue and accept the security certificate when the Internet Explorer web browser prompts 
you to proceed to the secure page. This prompt appears only once for each Media Server.

b. Select one of the following options:

 – Open—Plays the file using your default video player.

Table 7 Filters For Searching Clips 

Field Description

By Clip Name The full or partial name for the clip(s), which is entered when the clip is created

By Tag Tags associated with the clip.

By Clip Status Select the status for the displayed clips. Any status not selected will not be displayed.

By Clip Owner Select Owned by me to display only clips you created De-select to display clips created by other users.

By Camera The camera name where the clip originated.

By Location Clips created by all cameras at the selected location(s).

By Server Clips created by all cameras associated with the selected servers(s).

Table 8 Video Clip Information 

Field Description

Clip Name The clip name entered when the clip was created. The default is “My Clip” if no name is entered.

Camera Name The camera name where the clip originated.

Start Time The start timestamp for the clip.

End Time The end timestamp for the clip.

Clip Expiration The date/time when the clip will be deleted from the server.

Clip Status In-Progress, Completed or Failed

Location Location of the cameras where the clip originated.

Media Server The Media Server that manages the camera video where the clip originated. 

Clip Owner The user that created the clip.

Tags Tags associated with the clip.
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 – Save —Saves the file to the default location using a default filename.

 – Save As—Enter a new filename and select a location on the local disk. 

 – Save and Open—Saves the file to the default location using a default filename, and then plays 
the clip using your default video player.

Step 8 (Optional) To permanently delete a clip from the server, select one or more clips and click Delete. 

Note Only the server file is deleted. Any clips previously downloaded to a local disk are not affected.
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Understanding the Additional Video Viewing Options
Live and recorded Cisco Video Surveillance video can be viewed using a Cisco-provided application, as 
summarized in Table 9, or a third-party application that supports ActiveX controls. 

Table 9 Summary of Cisco Video Viewing Options

Viewing Tool Application Description Additional Documentation

Web-based 
configuration and 
monitoring tool

Cisco Video 
Surveillance 
Operations Manager

(Operations 
Manager)

 • Allows simultaneous viewing of 
multiple video panes:

 – View up to 4 cameras with the 
32-bit version of Internet 
Explorer. 

 – View up to 16 cameras with the 
64-bit version of Internet 
Explorer. 

 • Create the Views and Video Walls 
available in the desktop Cisco SASD 
application. 

 • Configure the camera, streams and 
recording schedules.

Cisco Video Surveillance 
Operations Manager User Guide

Desktop monitoring 
application

Cisco Video 
Surveillance Safety 
and Security 
Desktop

(Cisco SASD)

 • Allows simultaneous viewing of up to 
16 cameras. 

 • Create Video Matrix windows for 
display in separate monitors.

 • View Video Walls.

 • Create unattended workstations.

 • View and manage alerts.

 • View cameras, video, and alerts based 
on a graphical map.

Cisco Video Surveillance Safety 
and Security Desktop User 
Guide

Tip Go to Operations > 
Software to download 
and install the 
application.

Desktop video clip 
player

Cisco Video 
Surveillance Review 
Player

(Cisco Review 
Player)

Simple player used to view video clip 
files.

Cisco Video Surveillance 
Review Player

Tip Go to Operations > 
Software to download 
and install the 
application.

Web-based server 
console

Cisco Video 
Surveillance 
Management 
Console

(Cisco VSM 
Management 
Console)

Provides basic viewing features for a 
single stream (Stream A) from a single 
camera.

Cisco Video Surveillance 
Management Console 
Administration Guide
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Related Documentation
See the Cisco Video Surveillance 7 Documentation Roadmap for descriptions and links to Cisco Video 
Surveillance documentation, server and storage platform documentation, and other related 
documentation.
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